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Getting Started with
B Quick Blogcast

Welcome to Quick Blogcast!

Quick Blogcast is a remarkable tool that helps you create a quality blog and podcast site.
As you become familiar with all that Quick Blogcast has to offer, you'll be amazed at how
quickly and easily you can build your own unique blogcast site.

Quick Blogcast includes everything you need to:

m Create a professional blog.

Easily record and upload podcasts to share with visitors to your site.
Allow visitors to subscribe to your blog entries and podcasts.

Include RSS feeds, Twitter links, Flickr, and many other services.

Customize your site to suit your taste.

What is a Blogcast?

A blogcast is simply the combination of a blog and podcast into a single Web site. A blog

is a weblog, or journal, that is available on the Internet. A podcast is an audio or video file
that you share with visitors or subscribers to your site. Quick Blogcast enables you to eas-
ily create both; you don't have to choose one or the other. Additionally, with Quick Blog-

cast, you can freely add text, photos, and music to your blogcast entries.

SETTING UP YOUR ACCOUNT

The first step to get started is to set up your account. You need to enter some basic infor-
mation and specify the domain name you want to use for your Quick Blogcast site.

» To Set Up Your Account
1. Login to your Account Manager.

2. In the My Products section, select Quick Blogcast.
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3. Click Setup Account next to the account you want to set up.

" | Quick Blog Account Control Panel

[ COOLEXAMPLE.COM Manage Account
Gick Blog - 1 yvear

[ Mew Account Setup Account
Giick Blog - 1 year

|| Quick Blog Account Control Panel

4. To accept the End User License Agreement terms of use, click Accept.

5. From the Create New Blogcast Site page, enter the following information:

Display name
Enter your name as you want it to display on each entry you post.

Email
Enter your email address.

Domain
Select one of the following options:

Create a new subdomain
Enter the subdomain prefix and select one of the domains in your list.

Select an available domain from your account
Select from the list of available domains already associated with this account.

Enter a domain not registered here
Enter the full domain name. For example, www.coolexample.com.

Account Settings

Display name: £

Email: &

Domain:
Set up your Guick Blogeast site as a subdomain of ane of your domain names, select a different domain from your account, or enter a domain that is registered with another
Registrar to associate with your Guick Blogeast site

Ifyou use a domain registered with another registrar, you need to update the A Recard' for your domain so it points to the IP address 208.108.80.14. Check with your domain
name registrar for more infarmation.

& Create a new subdomain
¢ Select an available domain fram your account:
¢ Enter a dormain not registered here

I E

6. Click Save.

You have set up your blog. We sent a user name and password to the email address you
provided. You can now update your author information or start designing your blog site.
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To Update Your Author Information
From the Manage Blog menu, select Author Information.

Click Edit next to your Display Name.

w N =

Edit the author information in the following fields:

First Name and Last Name

Enter your first and name.

Display Name

Enter your name as you want it to display on each entry you post.
Email Address

Enter your email address.

User Name

Enter a user name.

Password and Verify Password

Enter and verify a password.

» To Design Your Blogcast Template
1. From the Design Blog menu, select Templates/Colors.

2. On the Templates and Colors page, use the slider to locate the template you want to
apply as the basic design of your site.

3. Click the template to select it. If you decide to select a different template, simply click
the new template. Your selection displays in the Sample Layout section.

Sampie Layout

B Real sl B Rpal Etate § B Fraral Ebata 2 O Aad Elaie 3
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4. In the Select Color Theme area, click a preview image to select a color theme. You
can view the color choices in the Sample Layout section.

S Lownd

Your Title' Text % E o Tmm :

--l

5. Click Next.

the design of your Quick Blogcast site. See chapter five, for more information on

Q From the Customize Template page you have many options to further customize
naTe Customizing your site.

6. Click Publish.

e,

Springdale Community News

@ If you want to update your template, you can return to the template designer

at any time by selecting Templates from the Design menu.
NaTE
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GETTING HELP

After you set up your account, you can always find help in the Help Center.
To Access the Help Center

Log in to your Account Manager.

4

1

2. From My Products, select Quick Blogcast Accounts.

3. Click Setup Account next to the account you want to work with.
4

From the Help menu, select Online Help.

The Help Center, which is a knowledge base with the most current informa-

. tion, opens in a new window.
NoTE

5. Under Select Your Product, click Site Builders, and then select Quick Blogcast.



Adding Content to
B Your Blogcast Site

After you have designed your Quick Blogcast site, you are ready to begin adding entries.
With Quick Blogcast you can add entries consisting of text, audio and video podcasts, and
images. You can even combine these elements in a single post.

Quick Blogcast offers a variety of ways you can interact with your blogcast site. For
instance, Quick Blogcast supports remote blogging and blogging by email. Let’s examine
the most common way of adding an entry to your site.

ADDING A BLOG ENTRY TO YOUR BLOGCAST

» To Add a New Entry

1. From the Manage Entries menu, select New Entry.

Manage Entries =  DesignBlog =  ManageBlog = =

Mewe Eritey

Modify

Entries Y
‘samplel] Files

Commerts
Trackbacks Your Title Text

2. In the Title field, type the entry title.

3. In the Categories field, enter a category. Alternatively, you can add and select a
recurring category from the categories section on the left.

4. Enter the body of your entry in the text area. You can use the formatting tools at the
top of the text area to format your entry.
Title: ¥elcome! |
Categenies: Todays Mows |
: Formatting Tools
Wite  HTML

DECE - N avEle

| ‘Welcome to our sibel We hope you w'.ﬁnnma an wisit often. We will past mmportant news regarding our community on a
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5. From the Entry Settings toolbox on the left, you can configure your entry settings in
the following ways:

Status

Select whether you want to save the entry as a Draft or to Publish it when you click
Save. Saving in Draft status is helpful if you want to create an entry, but are not ready
to have it display on your site.

Timestamp
Enter the date and time that you want to display in the time/date stamp.

Comments Status
Select if you want to allow comments and set the default status of comments made to
Open or Closed.

Allow Trackbacks
Select if you want to allow trackbacks and set their status as Open or Closed. Track-
backs let you know if someone is linking to your article.

Outgoing Trackbacks
Enter one or more URLs that you want to notify of the creation of your entry. You can
ping (notify) other blogs that you refer to in your entry or online blog directories.

Permalink

Specify the name you want to use for the permanent link to this blog entry. If you do
not specify a Permalink name, Quick Blog assigns a name after you save the entry.
The Permalink name cannot be edited after the entry is published.

F Entry Settings
Status:

Draft R
Timestamp:

Bi14/2007 3:54:00 FM |
Comment status:

Open &

Allow Trackbacks:
“Dpen v |

Qutgoing trackbacks:

Permalink;

,-".E.; I.IIIII".-',-".III E..:-"-lf.l,.-"-we leoome

r Cateqgories

b Excerpt
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6. From the Categories toolbox you can add and select categories to organize your
entries, so you do not have to manually enter a category for each entry.

m To add a category, type the name of your category in the text field and click Add.
The category displays under the entry box. You can repeat this process to add addi-

tional categories.

B To assign an entry to a category, click the category you want to use from the cate-
gories toolbox. The category displays in the Categorized field, under the Title field.

¢ Entry Settings

b Categories

| [ add
Education in Town

For Sale

Today's Mews
Lpcoming Events

b Excerpt

7. In the Excerpt toolbox, you can enter or paste an excerpt from your entry. This
excerpt displays on the blogcast page under the title of your entry.

8. Click Save.
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ADDING A PODCAST

Quick Blogcast has found a creative way to merge blogs and podcasts, including the post-
ing of both audio and video. Podcasts are added to your site in much the same way a blog
entry is added. In fact, the procedure is essentially the same.

There are two ways in which to add a Podcast to your site. You can upload an existing file
to Quick Blogcast or you can create a podcast using our Quick Recorder.

What Are ID3 Tags?

Before we add our podcast, let’s explore ID3 tags. ID3 tags allow information such as the
title, artist, album, track number, or other information about the file to be stored in your
podcast file. This information is available to the listener and can be displayed on most

MP3 players. Including this information also allows your podcast to be indexed by search
engines and iTunes.

» To Upload a Podcast to Your Site
1. From the Manage Entries menu, select Add Podcast.

2. Click Browse and select your podcast file.

Upload Media File {mp3 and mp4)

>

Browse LIPLOAD

Current Directary Usage: 0 MB of 300 MB

3. Click Upload.

Record Podcast | Install Recorder

Upload Media File {mp3 and mpd)

'Files selected to upload: Our
First PadcastMF 3
53 46KB

¥

" Browse “UPLOAD
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4. Enter ID3 tag information by completing the following fields.

Subtitle
Enter the subtitle of your podcast episode. Often, the subtitle explains the main title.

Composer
Enter the composer's name. This can be the podcaster’s name, or the author of a
book or music.

Album Info
Enter information you want to include about the album the file is from. This entry is
not necessary if the entry is not part of a larger compilation of work.

Podcaster
Specify the name of the person who created the podcast.

Podcast Summary/Description
Enter a summary of the podcast or comments you want to include about it.

Copyright Message
Enter copyright information for the podcast. Typically this includes the word “Copy-
right,” the year of publication, and the name of the owner of the entry.

Keywords

Keywords are words that explain or summarize your entry. Keywords help direct
search engines and directories to your entry or blogcast site. Keywords should be sep-
arated by a comma.

Explicit
In the explicit drop-down box, you can select whether or not to mark your entry as
containing explicit content.

You can set ID3 tag settings for each individual podcast, or set the ID3 tag set-
m tings to apply to every podcast published to your site. To make the ID3 infor-
b mation apply to each future podcast, select Use as default for ID3 tags at
note  the top of the ID3 settings list.

Edit Podcast

| Anytown July Meeting =]
[~ Use as default for D3 tags.

Irnage: [

SubTitle: Caomposear:

iTown Hall Meeting IS. Brown

Alburm info: Podcaster:

[Juty |

Fodeast Summary f Description Copyright Message

Cur July towhn hall meeting. We 411l rights reserwved by author.
discussed highway expansion.

Keywards Explicit:

itown hall. meeting, highway expansion !ND j




Adding Content 11

5. Click Save.

!

Congratulations! You have successfully added a podcast to your blogcast site.

You can also record a podcast directly to Quick Blogcast using our Quick Recorder, our
fully-functional podcast recorder. However, you first need to install it on your computer.

m Currently, Quick Recorder is only available for PC users.
-

NnaTE

To Install Quick Recorder on Your Computer

From the Manage Entries menu, select Add Podcast.

Click Install Recorder.

Click Install. The Application Install - Security Windows displays.
Click Install.

i 4

To Create a Podcast with Quick Recorder

1. Open Quick Recorder.

2. On the Sound Settings tab, you can enable the following options:
Vocal Compression

Enables vocal compression for your recording. Select Low Compression or High Com-
pression.

Mic Boost

Doubles the volume of the sound coming into the recorder.
Phase Shift

Adds a phasing effect to your recording.

3. Adjust the level of sound going into the recorder using the gain fader slider located
below the File menu.

4. Click Record (red circle).
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5. In the File name field, enter a title for your recording and click Save. Quick Recorder
starts recording.

6. When you are finished recording, click Stop (green square).

To hear your recording, click Play (green arrow).

4 The gain fader on the left side of the recorder adjusts the input level. It does
. not adjust the output volume.

NoTE

After you've uploaded or created content, you are ready to publish your entries to the
Internet so they can be enjoyed by visitors to your site.



Previewing and
m Publishing Your
Blogcast Site

Now that you have designed your site and added some entries, it is time to publish your
site to the Internet. Quick Blogcast gives you the option of previewing your site as you
make changes, showing you how it displays on the Internet. This step gives you the
option of making any changes before the site is actually published.

PREVIEWING YOUR SITE

You can preview your site at any time, to see how it would display on the Internet.

ever, your changes do not display on the Internet until you publish your site.

9 Any changes you make to your site display when you preview your site. How-
You can publish your site as often as necessary.

NoTE

To Preview Your Site
From the Design Blog menu, select Customize.

You can view your site in the preview window located in the center of the page.

w N =

To see any recent changes, click Update Preview.

2 4 ke sla. e el Lo B 8 gk et o

7 A e 1211 Add Eommant
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PUBLISHING YOUR SITE

Congratulations! You are ready to publish your site. After publishing, your site updates
display on the Internet.

» To Publish your Site
1. From the Design Blog menu, select Customize.

2. Scroll to the bottom of the page and click Publish.

e [ (o]
B 11 1 =il e
Qooooooc

Templits Solae Beicigraurd Fopast
EE E (Em (o E

ROmECEE

e S O e L e R 5 | e ALK T SN Al
'HIGH SCHOOL BAND AND CHOTR PERFORMANCE
-. FUICKEEARCH
Playec: O | Downioad | Duraton: 00:00:03

n

Foearch |

X el

hatthia \The the
mmﬁ_ o TDNSOR TAM R SO S G E SO et o

>
Great job! You have built a complete blogcasting site. If you are interested in learning
how to manage your site, or further customize your template, the following chapters
guide you through Quick Blogcast in greater detail.
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You can add as many new entries to your blogcast site as you want. However, the entries
do not display on the Internet until you publish them. You can publish specific entries,
leaving others unpublished. You can also remove entries from your site; this is referred to
as deleting your entry. A deleted entry no longer displays on your site, but is easily recov-
erable. This feature gives you the ability to archive past entries and re-publish them at a
later time.

MANAGING ENTRIES

From the Manage Entries page, you can quickly manage your site content. You can work
with one entry or multiple entries. To perform an action, select the checkbox to the left of
the entry or entries to which you want the action to apply, and then perform the update.

» To Publish a New Entry

1. From the Manage Entries menu, select Entries.

Home Manage Entriges = Design Blog = Manage f']ll'_:-l:'j

_. Ia action...

2. On the Manage Entries page, there are two search options to sort your entries in the
Entries list.

View
Select a Month/Year from the Month Search drop-down list and click View.
Search

Select whether to search the Title, Title and Contents, Category, Status, or Author,
then enter a keyword, and click Search.
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3. Publish entries by doing one of the following:
m Click the publish icon next to the entry that you want to publish.

m Use the checkboxes to select the entries you want to publish, and then select
Publish Entries from the Select Action drop-down menu and click Apply.

Manage Entries (= il [Fre==Tl
[Crreane Enry |
L T | seaich: | Tiew =] [Csearn ]
Eadar] mbian ¥ Apply sl 10w Sy 1.4 w08 0
Dala Tile Rastlisy Catlogpra joy Sy Acttim
T il it Chedit Portarmance Bl 8 Puttishad | [Ty w][u]
riprert T s Pasanes  [H]EI[RI[D
::IEI.‘.:;'- Hodiday Paras valariis ic]
R Maphs SostCat now open B zEe wwt

RATNTY 1-4 = & d

In the Display select box, you can select to display 10, 20, 50, or 100 entries

m per page. If there is more than one page, change pages by selecting a differ-

L ent option from the Showing menu.
NnoTE

» To Delete an Entry

Deleting an entry removes the entry from displaying on your blogcast site. It does not
remove the entry from your account. The entry can be recovered at any time from the
Manage Entries page.

1. From the Manage Entries menu, select Entries.
2. In the Entries List, locate the entry you want to delete.
3. There are two search options to sort your entries in the Entries list.

View
Select a Month/Year from the Month Search drop-down list and click View.

Search
Select whether to search the Title, Title and Contents, Category, Status, or Author,
then enter a keyword, and click Search.

4. Delete entries by performing one of the following actions:
m Click the delete icon next to the entry that you want to delete.

m Use the checkboxes to select the entries you want to delete, select Delete Entries
from the Select Action drop-down menu, and then click Apply.
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>

To Recover a Deleted Entry
From the Manage Entries menu, select Entries.
From the Search menu, select Status.

In Search field, type Delete, and then click Search. A list of deleted articles
displays.

Use the checkboxes to select the entry(ies) you would like to recover.
From the Select Action menu, select Publish Entries.

Click Apply.

MANAGING COMMENTS

Comments make your site interactive by allowing visitors to share their thoughts on your

posts. Quick Blogcast allows you to manage comments in various ways.

With Quick Blogcast, you can choose to view all or a portion of the comments submitted

to your site. To view a certain type of comment, use Quick Blogcast's filtering option.

>

1.

2.

To Filter the List of Comments

From the Manage Entries menu, click Comments.

Home | "piznfia:__j,a.‘iluz'}:iéﬂ S !Jaaji;;r.-*i:ﬂu::_] ~=  Manage i‘:}'_rlf‘] = Help =
Home; § MewErtry News
Ertries
Files
e e =
Blog Trackbacks URL (Web Address) Ent

From the View list, select one of the following and then click view.

All
View all comments.

Pending Approval
View all comments that are pending approval.

Approved
View all approved comments.

Spam
View comments that were marked as spam.

Deleted
View deleted comments.

Showcased
View showcased comments. Click View.
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Manage Comments

WVieww | All Vf View

Select action... v || Apply | Displa

[] Date Comment

0B 2007

0506 PM | have been waiting for the cafe to

Lastyearthe parade was 3 lofof ..

]

06/19/2007
L os:03pu
O]

0EM Q2007

02:44 EM | can'twait We need a new school ...

The Manage Comments page displays the type of comments you have chosen to view.

Viewing Comment Contents

In the Comments list, you can select to display 10, 20, 50, or 100 entries per page. If
there is more than one page, change pages by selecting a different option from the Show-
ing menu.

» To View Comments

1. From the Manage Entries menu, click Manage Comments.

2. Click the expand icon next to the title to view the content of the comment.
3. Click the entry title the comment is associated with to open the entry in the Entry

Editor.

Manage Comments

Wow: | Al w [ ¥rew Seanth CommenBody
.;anlur.'lxbun w [P Rty f m T

] Date Coamment Enty Ruslyon
0 ﬁ;:‘g&w | naen haon waing for the cafe o o WM Sup Felers
D ﬁ;’gﬂ&ﬂ? mlgwﬂgilmm&ulnlﬂ. Cbi:] :::IIII Parade Volnteers WaryJonss

Last year the parade was a Iof of fun. [ encourage everyona o go this yoar. | will volundess this vear. Coma join ug!

0 g?i?g&m Lcant waill W neid o new School . [ Hew scheni opbning Jok King
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Managing Comments

From the Manage Comments page, you can approve or delete comments, ban IP
addresses, or mark comments as SPAM.,

>

1.

To Manage Comments
From the Manage Entries menu, select Comments.

Select the comments that you want to manage using the checkboxes located to the
left of each comment.

061972007

0503 PM Lastyearthe parade was alotof.. $f

o OB 32007 .
v 0744 P | can'twait We need a new school .. 5%

From the Select Action menu, select one of the following options.

Add to Showcase

Adds the selected comments to the Showcase. When a visitor click on the sidebar
Showcase link, the selected comments display on a new page. To enable this, you
must activate the Showcase component from the Sidebar page.

Approve Comments
Approves the selected comments, allowing them to be read by your site visitors.

Ban IP Address
Blocks a specific authors from commenting. This is done by detecting the author’s IP
Address and blocking future submissions from that address.

Delete Comments
Deletes selected comments.

Mark Comments as SPAM
Marks the selected comments as SPAM.

Print Selected Comments
Prints the selected comments.

Remove from Showcase
Removes the selected comments from the Showcase.

Wigw: | All v |[[T¥iew |
selectaction..._______{w [ Apply

Add to Showcase
Approve Comments
Ban IP Addresses miting for the cafe to ...
Delete Comments
Mark Comments as Spam
Print Selected Comments parade was alotof
Remove from Showcase
Lastyear ine parade was alot of fun, | encourage ey

From the Manage Comments page, you can easily organize and manage the comments
submitted to your site. Enjoy!
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CUSTOMIZING YOUR TEMPLATE

The Quick Blogcast Customize Template page gives you the tools to completely customize
your blog site and easily create the site you want.

Let’s take a look at how to customize your blogcast site.

» To Customize Your Template

1. From the Design Blog menu, select Customize.

Home Manage Entries =+ Design Blog + Manage Blog

Modify Template

2. In the following fields, edit the elements you want to change:

Header Text
Edit the text that displays in the header of your site.

Header Link URL (Optional)
Edit the URL that displays in the header of your site. Also, select whether you want
the link to open in the same window or in a new or window.

Subheader Text
Edit the text that displays below the header. This is often a sub-title.

Footer Text
Edit the information that displays at the bottom of your Web page.



Customizing Your Template 21

Select Element
You can select an element of your template that you want to customize. The following
fields can be used to edit the selected element:

m Font/Foreground and Background
Specify whether you want to edit a font/foreground color, or background color,
using the color picker.

m Font Style and Font Size
Select a different font and/or size for the selected element.

m Select Color
Select a color from the color palette for the selected element.

m Select Background
Click Replace Image to add an image or replace the existing image. Select from
your uploaded images or click Browse to select a background image you want to
upload to your site. Click Open from the dialog box and then click Upload.

m Background Repeat
Select how the selected background displays on your site.

|
Advanced Style Sheet

Header Text: Header Link URL:thot requirad) Subheader Text: Footer Text:
Jhttai
Open in:
¢ Mew window ¢~ Current window
Select Element Foni Style Font Size
| Blog Body =|  FantForeground ¢ Backaraund | verdana = |12 =l
Select Color Select Background

14

I Hex values (what is this?) 2dh HE s B

| #|FFFFFF il e Image || Remove
I Recent Colors

i_i 5] !_i ‘_| |_| |_| ‘_| |_| Background Repeat:
1 e e e o e e T | no repeat =
Template Colors ' -
(NN EN.
[} § Im} I

Apply Changes f Upd

3. To view your changes, click Apply Changes / Update Preview. You may edit any
of the above fields at any time and as often as you want.

4. To publish your changes to the Internet, click Publish.

| Apply Changes f Update Preview |

| Publish | | Cancel |

5. If you want to view your site as it displays on the Internet after publishing, click View
Blog. You can also type your URL into a browser. Clicking View Blog takes you
directly to your site from the site builder.

Your newly designed site is now ready to be enjoyed by visitors.
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Listed below are terms that are common in the world of blogging, podcasting, and blog-
casting.

GLOSSARY

Adsense, Adbrite, CJ, Chitka, Blogads

Popular affiliate programs used to generate money from your blogcast account.

Archives

A collection of all your posts on one page. Can be categorized by month or category.

Blog

Shortened term of Weblog. A weblog is a journal (or newsletter) that is frequently
updated and intended for general public consumption. Blogs generally represent the per-
sonality of the author or the Web site. A frequent and chronological publication of com-
ments and thoughts on the web.

Blogcast

A blog and podcast merged into a single website.

Blogger

A person who owns or writes for a Weblog.
A person who blogs.

Blogging
The act of posting on blogs.
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Blogosphere

The Internet blogging community.

Blogroll

List of links to other blogs located in your sidebar.

Categories

A collection of topic specific posts.

Commentator

A person who leaves remarks or a comment regarding an entry in a blog.

Comments

Enabling readers to leave their remarks.
Remarks left by readers.

Del.icio.us, furl, spurl

Social bookmarks used to share favorite sites.

Entry

Individual articles that make up a blog

Expandable post summaries

A small teaser part of the post on the index page that links to a full post.

Flickr, Imageshack

Photo sharing services through which you can host images on your blog.

Footer

The bottom portion of the blog, usually listing navigation and copyright statements.

Header
The top portion of the blog, usually listing the blog title.
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Index page

The front page of your site.

Permalink

A link to a specific article in the archives of a blog, which remains valid after the article is
no longer listed on the blog's front page.

Podcast

A form of audio and video blogging that allows users to subscribe to a feed and receive
new files automatically by subscription.

Podcasting

A method of distributing audio and video files online. Podcasting often uses feeds for
playback on mobile devices and personal computers. Podcasts are created by podcasters.

Post, Entry

Individual articles or audio/video posts that make up a blog or blogcast.

RSS

RSS is a Web content syndication format. RSS is an acronym for RDF Site Summary,
Really Simple Syndication, or Rich Site Summary. Using RSS, you can subscribe to Web
sites, such as news sites and blogs, and add the subscription to your blog. Content, or
posts, from the Web site you subscribe to display on your Web site. Subscription content
updates in real-time, that is, when the author submits an updated post, your Web page
reflects the update.

A family of web feed formats used for Web syndication. Short form for Really Simple Syn-
dication (RSS 2.0), Rich Site Summary (RSS 0.91, RSS 1.0), RDF Site Summary (RSS 0.9
and 1.0). Wordpress generates RSS 2.0

RSS Feed

RSS feeds provide items containing short descriptions of web content together with a link
to the full version of the content.

Sidebar

One or more columns along one or both sides of a blog’s main page, usually used for
links, calendars, or lists.
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Social Bookmark

Social bookmarking allows user to take bookmarks suggested by others and add them to
their own collections. Users can also receive bookmarks by subscription.

Spam

Spam refers to unsolicited online messages. Most Spam is used for marketing; however,
Spam can also occur in the form of blog comments. This form of Spam is created by an
author who posts a link in the comment, for commercial purposes.

Trackback

A trackback sends a ping to another Web site equipped for trackbacks, notifying the site
that a new link has been created. Trackbacks notify the author of an entry that the post
has been added to another blog.

Web Feed

Allows users to subscribe to Web sites that regularly update or add new content.

Weblog

An online diary listing your thoughts on a specific topic, usually displayed in reverse chro-
nological order.



